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1. Introduction

1.1 Preface

Elecard Video Quality Estimator is a powerful tool designed for professionals and prosumers in the
video compression field.

Elecard Video Quality Estimator allows the user to calculate objective video quality metrics, such as
PSNR, APSNR, SSIM, DELTA, MSE, MSAD, VOM, NQI, VIF, VMAF and VMAF phone to compare
two streams with referenced RAW data, analyze differences, and identify the code portion causing the
quality change.

1.2 Describing Elecard Video Quality Estimator
The following section defines the specification and features of Elecard Video Quality Estimator.

1.2.1 Supported Video Formats

MPEG-1 Video stream,

MPEG-2 Video stream,

AVC/H.264 Video stream,

HEVC/H.265 Video stream,

VVC/H.266 Video stream,

VP9 Video stream,

AV1 Video stream,

AVS3 Video stream,

MPEG-2 Transport Stream (MPEG-1/2, AVC, HEVC),
MPEG-2 Program Stream (MPEG-1/2, AVC, HEVC),
AV file container (MPEG-1/2, AVC, HEVC),

MP4 file container (MPEG-1/2, AVC, HEVC, VP9, AV1),
MKY file container (MPEG-1/2, AVC, HEVC, VP9, AV1),
WebM file container based on MKV (VP9, AV1),

IVF file container (VP9, AV1),

FLV file container (AVC, HEVC),

MXF file container.

1.2.2 Supported Raw Formats

1444

1422

YUV

NV12

NV21

P444

RGB24

RGB32

UYVY (Y422, UYNV, HDYC)

www.elecard.com 4
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V210

V400

V444

Y42B

YUY2 (YUNV, V422, YUYV)
YV12

YV16

YVYU

1.2.3 Metric Types

PSNR — Peak Signal-to-Noise Ratio.

APSNR - average values of PSNR results calculated for a sequence and based on mean values
of MSE results.

VQM - Video Quality Measurement Techniques — a metric designed to calculate video quality
and measure perceptual effect of video distortions.

SSIM - Structural SIMilarity. This metric is based on measuring three components (luminance
similarity, contrast similarity and structural similarity) and combining them into result value.
DELTA - the value of this metric is the mean difference of the color components in the
correspondent points of image.

MSE — Mean-squired-error based metric.

MSAD - the value of this metric is the mean absolute difference of the color components in the
correspondent points of image.

NQI — New Quality Index - is a metric designed to calculate video quality by combining three
components: correlation loss, luminance and contrast distortion.

VIF - Visual Information Fidelity - is a full reference image quality assessment index based on
natural scene statistics and the notion of image information extracted by the human visual
system.

VMAF - Video Multimethod Assessment Fusion is an objective full-reference video
quality metric developed by Netflix in cooperation with the University of Southern California.
VMAF phone — a metric designed to predict the quality of videos displayed on mobile phones.

1.2.4 Features

Calculation of video quality metrics (PSNR, APSNR, MSAD, MSE, SSIM, DELTA, VQM,
NQI, VIF, VMAF and VMAF phone);

Selection of ROI (region of interest) for metrics calculation;

Display of essential statistics of encoded streams;

Automatic selection of the similar first frame in two streams for analysis synchronization;
Comparison of two encoded frames from different streams with a reference stream;

Sharing comments between application instances and/or applications of Elecard StreamEye Studio
set;

Synchronization between applications of Elecard StreamEye Studio set (Binding mode);

Bit distribution display;

Command line tool,

Saving data into CSV or text files;

Display of comparison results in graphs: quantizer, frame size, bit allocation etc.

www.elecard.com 5
sales@elecard.com


https://en.wikipedia.org/wiki/Video_quality
https://en.wikipedia.org/wiki/Video_quality
https://en.wikipedia.org/wiki/Netflix
https://en.wikipedia.org/wiki/University_of_Southern_California

Elecard Video Quality Estimator 2023 e ’ d
UserGuidIe R HH E EEE’_

1.3 Using the Guide

1.3.1 Purpose

This guide is intended to help the user utilize Elecard Video Quality Estimator. It describes the Video
Quality Estimator GUI, settings and functions and provides instructions for using Video Quality
Estimator.

1.3.2 Topics Covered

The following lists the topics covered in this document:

e Section 1: Introduction — provides a general overview of Video Quality Estimator and
describes the purpose of the document and its contents.

e Section 2: Getting Started — describes how to install, uninstall and run Video Quality
Estimator.

e Section 3: Using Elecard Video Quality Estimator — describes the Video Quality Estimator
GUI, provides instructions for comparing video streams and viewing the results of comparison.

e Section 4: Command Line Tool — covers advantages and features of Command Line Tool, and
describes a list of commands applied for automatic analysis of media streams.

1.3.3 Related Documentation

For additional information, review the following documents:

ISO/IEC 11172-2 for MPEG-1 video

ISO/IEC 13818-2 for MPEG-2 video

ISO/IEC 14496-10 for AVC/H.264 video

ISO/IEC 23008-2 MPEG-H Part 2

ITU-T Recommendation H.265

H.266 Versatile video coding

A VP9 Bitstream Overview for Google VP9

AV1 Bitstream & Decoding Process Specification

AVS3 (Information Technology Intelligent Media Coding (T/Al 109.2 — 2021) by Industry
Alliance Standard)

1.4 System Requirements

1.4.1 Hardware Requirements

e 4 GB RAM for video resolution below HD,
e 8 GB RAM for HD video (or higher).

1.4.2 Software Requirements
e Windows® 7/8/10 (64-bit).

1.5 Licensing and Technical Support

By installing, copying, or otherwise using the SOFTWARE PRODUCT or any UPDATES, you agree
to be bound by the terms of the "Elecard" End-User License Agreement ("EULA"). This EULA is a
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legal agreement between you (either an individual or a single entity) and Elecard for the "Elecard"”
software product(s) accompanying this EULA, which include(s) computer software and may include
"online™ or electronic documentation, associated media, and printed materials ("SOFTWARE
PRODUCT").

For technical support, please contact Elecard Technical Support Team: tsup@elecard.com
For sales and licensing information, contact Elecard Sales Department: sales@elecard.com

1.6 Activating Elecard Video Quality Estimator

1.6.1 Sentinel License Protection

Make sure that Sentinel License Manager software has been installed on your computer. License
Manager is provided within the product installation pack for Windows OS and installed automatically.

License Manager is provided as a separate installation pack for Linux OS and macOS and should be
installed manually.

Please note, Windows reinstallation will make the activated product license invalid.

To check that License Manager is properly installed, go to Sentinel Admin Control Center at
http://localhost:1947. If you see your license information, the installation is successfully completed.

gemalto Sentinel Admin Control Center

Sentinel Keys
Products

Features
Sessions

Admin Control Center

Update/Attach

S Run-time Installer 7.81.80610.1
Diagnostics Sentinel License Manager 21.1.1.80248
@ 2018 SafeMet, Inc. All rights reserved.

£l

Figure 1.  The License Manager with license information

License Manager allows configuring, controlling, monitoring and looking through a list of available
licenses. For more details on License Manager operation click the Help tab.

Note, each page contains the Help tab related to this page only.

You can activate Elecard Video Quality Estimator offline via following steps:

For Elecard Video Quality Estimator activation, a C2V (client-to-vendor) file should be created. To
create the C2V file follow the steps:

1. Open the File tab and select Options in the drop-down menu.

2. Adialog window should open. Open the License tab.

3. Select HASP-SL for PC-based or HASP-HL for dongle-based activation in the Offline
activation with license files field. Note, if you select a PC-based (HASP-SL) activation, full
featured activated Elecard Video Quality Estimator will run only on this particular hardware. If
you have Elecard dongle, plug it into a free USB port on your computer and select dongle-
based (HASP-HL) activation. It will be possible to use Elecard product on any hardware with

www.elecard.com 7
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the dongle plugged in.

4. Click the Collect license information button. The Save File dialog box should open. Click
Save and save the C2V file to a required directory. Send the saved C2V file to Elecard Sales at

Offline activation with license files
KEY ID = 781922996 TYPE = HASP-HL =

| Collect license information

Apply license update

Figure 2.  Offline activation with license files

sales@elecard.com.

Figure 3.

5. After receiving the V2C file containing license information back from Elecard Sales save the
received file to a required directory. Open the File tab and select Options in the drop-down
menu again. Open the License tab and click Apply license update (see Figure 4). The file
selection dialog box should appear. Choose the received V2C file and click OK. Your

Options X

ain Wigualization Binding Save License

Ondine activation with product key
- - Activate

Offline activation with license files
KEY ID = 1274313617 TYPE = HASP-HL =

Collect license information

Apply license update

License message: ready

Unlimit elernents [perpetual] [seats: 1 count each: station export:
Lirmit headers for TRIAL [perpetual] [seats: 1 count each: station e
HEVC Decoder [perpetual] [seats: 1 count each: station export: ne
AVC Decoder [perpetual] [seats: 1 count each: station export: neb
VWC Decoder [perpetual] [seats: 1 count each: station export: neb
MPEG2 Decoder [perpetual] [seats: 1 count each: station export: ¢
VPG Decoder [perpetual] [seats: 1 count each: station export: nety
AV Decoder [perpetual] [seats: 1 count each: station export: nety

Restore Defaults Cancel

Elecard Video Quality Estimator GUI — Creating a C2V file: License tab

application is successfully activated.
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2. Getting Started

The following section details the procedures for installing and running Elecard Video Quality
Estimator.

2.1 Installing Elecard Video Quality Estimator

Elecard Video Quality Estimator is supplied as part of Elecard StreamEye Studio or as a standalone
application. The application is installed via Elecard StreamEye Studio or Elecard Video Quality
Estimator installer.

Depending on the purchased product or version, the installation file is located:

e in Elecard folder as a separate application;
e in Elecard folder as a part of Elecard StreamEye Studio.

1. Run Elecard Video Quality Estimator Setup.

2. To complete installation, follow the onscreen instructions.

3. When setup has finished installing all the necessary files on your computer, the Elecard Video
Quality Estimator has been successfully installed dialog box will appear, and the program is
ready to run. You do not need to reboot your computer.

2.2 Uninstalling Elecard Video Quality Estimator

Elecard Video Quality Estimator can be uninstalled as part of Elecard StreamEye Studio or as a
standalone application

1. Click Start — Elecard — Elecard Video Quality Estimator — Uninstall Elecard Video Quality
Estimator 2023 and follow the instructions of the uninstaller.

2. Follow the on-screen instructions to complete the Elecard Video Quality Estimator
uninstallation.

2.3 Running Elecard Video Quality Estimator

To run Elecard Video Quality Estimator click Start — Elecard — Elecard Video Quality Estimator
2023
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3. Using Elecard Video Quality Estimator

3.1 Introduction

The following section describes Elecard Video Quality Estimator GUI (graphical user interface).

The Elecard Video Quality Estimator program has a simple user-friendly interface that allows the user
to perform a number of operations including: opening 2 encoded streams and 1 raw stream for
analysis, comparison and displaying the results of comparison along with basic parameters of the
encoded streams.

3.2 Describing Elecard Video Quality Estimator

The following section describes Elecard Video Quality Estimator GUI.

Elecard VideoQuest 2022 - o x
File View Navigation Help
BCOvW~yX & B~ @~ x05~ v B~ f Temperatwe v StreamA v StreamB v [~ |4 4| b D DI @& A v D1 [=R--N

Stream A 8 x A bbb_x265_900kbps. 265 X Diff: Temperatwe  RAW:bbb.yuv B :bbb_x265_1530kbps.265
name value %
stream type HEVC/H.265
Main
Main; Main 10
31/ Main
420
1280x 720
2500
undefined
00:00:10:000
count 250
i 7(280%)
P 52 (20.80%) -
8 191 (76.40%) —
size (byte) / encode ratio (avg) 4519/ 305
I 33393/ 41 —
3 8147/169 -
8 2473/558

SteamA  SteamB  Frame

Graphics 8 x
hvlxvPs\R v @~ T Il + —
i YUV: AB[41.383: 48.621] YUV: ARAW [40.243: 48.256] YUV: BRAW [42.715:50.251] Bt Alocation A; Bit Alocation B; Quantizer A; Quantizer 8;
name value 50.251
Y 41459 48.583
u 43481
v 4476
Avg 4295 sl
% 40602 N DESUA NG N s s oSN e NN TN TR N S
u 4267 N/ - 2 <! - 3 o
v 43,569 5297 (N [ A o e
Avg 42.098 i ¥ >
B - RAW | - £
% 2912 43.579 | NS, \ W .
u 44998 \}
v 45599
Avg 44344 aton |
40.243
€ 63 6 6 7 75 W 8L 84 8 S 93 9% S 102 105 108 11 14 117 120 123 126 129 132 135 1% 141
Graphics Comments
Disp: 94 Diff 2:0; bi0; raws0; Pos: 1120624 glecard

Figure 4.  Elecard Video Quality Estimator GUI — Main Window

3.2.1 ToolBars

The following table describes Elecard Video Quality Estimator toolbars.
Table 1.Elecard Video Quality Estimator GUI - Toolbars

Menu item Button Description
File
Open file = Opens media for analysis.
Reopen g Opens the recently opened files.
Save o Allows selecting parameters for saving and saves data:

e stream parameters of the whole file (metrics info, index info, stream info) in a .csv

www.elecard.com 10
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Close *
Binding
Options {§}
Color space ]
Scale x1
Grid +
ROI B4y
Output IN1]
Difference =
Go to
beginning 14
Previous <]l
Play / Pause b
Next |C»
Go to End (2]
Offset

Decrement /| ] i[x
Increment

file (file stores tabular data (numbers and text) in plain text. Each line of the file is
a data record. Each record consists of one or more fields, separated by commas or
semicolon);

o current frame parameters (YUV data and image including A, B, RAW, Difference)
as YUV or .png files.

The saving parameters can be also configured in the Options tab.

Closes the files.

Enables or disables the Binding mode:

e Leader —allows sending comments, commands on interface or positioning

changes to other applications;

e Follower — allows receiving comments, commands from other applications.
Opens the program settings dialog. Allows setting the number of files in a list, selecting
color theme, enabling the delete missing recent files automatically function, and
configuring the saving parameters.

View
Selects color space to be displayed: YUV, Y, U, V.
Sets the video scaling coefficient: x0.125, x0.25, x0.5, X1, X2, x4, x8.

Displays grid for convenience: none, 4x4, 8x8, 16x16, 32x32.

Region of interest (ROI) — limits analysis to the specified field: Normal / Inverse.
Values of ROI: X: -1; Y: -1; W: -1; H: -1.
Output — shows and activates the current window (A/ B / RAW / Difference)

Enables/disables the comparison of Streams A and/or B with the Raw stream. The

combo-boxes Difference Mode, Source 0, Source 1 are displayed.

The following Difference modes are available:

o Compare — pixel-by-pixel comparison of two frames. If two pixels are matched, the
result is 0. Otherwise the result is equal to the maximum value.

e Subtraction — pixel-by-pixel subtraction. The result is equal to the difference value.

e Temperature — absolute difference (pixel-by-pixel subtraction), results are
highlighted (black-blue-green-red), where black corresponds to zero difference,
blue corresponds to slight difference, green corresponds to medium difference and
red corresponds to the biggest difference.

e PSNR - the result is the PSNR values (from 0 to 99.99) for corresponding CU
partitioning blocks, where black color corresponds to O value, and white color
corresponds to the value of 99.99 and higher.

e PSNR Clip — the same as the PSNR, but minimum result value is the minimal
PSNR among all blocks in the frame and maximum - the maximal PSNR,
respectively. Black color corresponds to minimal value, white color corresponds to
maximal value, and blended colors correspond to intermediate values.

The following Source 0, Source 1 values are available: A, B, Raw.

Navigation
Go to beginning - sets the current position to the first frame in the stream.
Previous - sets the current position to the previous frame.
Play - starts and stops the stream playback.
Next - sets the current position to the next frame.
Go to end - sets the current position to the last frame in the stream.

Offset decrement / increment. Allows adjusting stream position relatively to others.

www.elecard.com
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File A - Allows choosing between streams: A, B, RAW.
Help

Feedback o Sends_ the Video Quality Es_timator feedback via e-mail with the following subjects:

Submit an Idea, Ask a Question, Report a Bug.
About =, Shows the About window.

Graphics

Barchart . il Showg a stream type and frame size: None, Clustered, Overlapping, Bit Allocation,
Configuration Quantizer, Graphics Mode.
Graphics | Displays stream graphics: A-B, A-RAW, B-RAW

Visualizes all metric types selected when opening streams in the New Task window:
Metric type APSNR PSNR, APSNR, MSAD, MSE, SSIM, DELTA, VQM, NQI, VIF, VMAF and VMAF
phone. None is displayed when no streams are selected.

Color space S Selects color space for display: YUV, Y, U, V.
Horizontal ] Adjusts graphics to the current panel size horizontally.
range

Vertical range T Adjusts graphics to the current panel size vertically.
Zoom In/ Out +,— Scaling up and down.

3.2.2 Graphics panel

To open the Graphics panel, click the View tab and select Graphics. A dialog window will open.
Graphics:

Graphics 3
lly» |-~ ~ PSR » @~ T &l + —

cteam | frame 116 YUV: A-B [41.383: 48.621] YUV: ARAW [40.243: 48.256] YUV: B-RAW [42.715:50.251)  Bit Allocation A; Git Allocation B; Quantizer A; Quantizer B;

name value 50.251

T
L3

41.863 48.25
44792
43479
43.746

Prcc=<?®
2

40.163
43.724
4921
42.28

Ter<c=<?
za

42486
43.881
45444
44563

pe<c=<

m
s
&

&0 63 66 69 72 75 7 81 84 87 90 93 9% 99 102 105 108 111 114 117 120 123 126 129 132

Figure 5.  Elecard Video Quality Estimator GUI — Graphics

The Graphics panel displays the video streams being analyzed. The bar height illustrates the frame
size and the bar color indicates the frame type (red — I, blue — P, green - B). The values displayed
above the graphics correspond to minimum and maximum calculated values for the selected metrics of
the component(-s).

To set the stream position to a frame, click the corresponding bar.

The Bar Chart Configuration button il — allows configuring Bar Chart presentation mode to display
additional information about the streams, including: frame size and type, bit allocation and quantizer:
None - is displayed when no configurations are selected.

Clustered — displays chart bars by A-B pairs under the corresponding display number;
Overlapping — displays overlapping (overlaid) chart bars showing variance between them;

Bit allocation — number of bits that are processed per a unit of time.

Quantizer — displays the frame mean Quantizer value.
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e Graphics mode — decreases chart bar brightness to focus attention on graphics. This option is
switched on by default.

To select stream graphics between A-B, A-RAW, B-RAW, click the |~ toolbar button and enable
checkboxes.

To see all the metric types selected for graphics displayed, click the Metric type tab "*"* ¥ None is
displayed when no metric types are selected.

To choose the component which metrics will be displayed in graphics, click the & button and select
the required streams. Click the ¥*l or & button to adjust the graphics to the reference window size
horizontally or vertically, the minimal size is 1 pixel per frame. Click the T / — buttons for upscaling
or downscaling the graphics.

Hover a cursor over a frame, the frame metric info is displayed.

name value
frame 0
Y 40,19
U 48,018
Vv 43,039
Avg 45415
ctream
Y 37,661
U 47 266
v 47175
Avg 44034

Figure 6.  Elecard Video Quality Estimator GUI — Frame Metric Information Window

3.2.3 Comments Panel

The Comments panel is designed for team work: share comments on a specific frame or group of
frames

in the stream, navigation and switching between different instances of the same application or different
applications contained in Elecard StreamEye Studio.

To edit, remove or send comments using the Binding mode, open the context menu by right-clicking.
The Send option enables you to pass the selected comment to the other application of StreamEye
Studio set or the other instance of Video Quality Estimator. To select an application from which
messages should be received or to select a type of messages to be received, go to the Options tab —
Binding or see more details in the Options Dialog section.

www.elecard.com 13
sales@elecard.com



Elecard Video Quality Estimator 2023 L ’ d
User Guide - E EEE,_

Comments 4
caption text
Frame #184 check it

N

Edit

Remowve

Send

Figure 7.  Elecard Video Quality Estimator GUI — Comments Panel

3.2.4 Stream Panel

The Stream panel displays the current stream summary information: stream type, profile,
compatibility flags, level, tier, chroma format, resolution, frame rate, declared bitrate, duration, epsnr,
frame types, average frame size, range of quantizer values bit allocation info, frame average bit
distribution in CU, prediction and transformation data.

Stream B g x
name value % o
stream type HEVC/H.265
profile Main
compatibility Main; Main 10
level / tier 3.1/ Main
chroma format 4:2:0
resolution 1280 x 720
frame rate 25.00
declared bitrate undefined
duration 00:00:20:160
frames
count 504
| 5 (0.99%)
P 106 (21.03%) m o
D 20 T OT0 | |
< >

Stream A Stream B Frame

Figure 8.  Elecard Video Quality Estimator GUI — Stream Panel

3.2.5 Frame Panel

The Frame panel displays the current frame summary information: stream / display number, type,
sizes, gp. If A and B streams are open, information for both streams is displayed simultaneously for
better user experience in analysis and comparison. The red color corresponds to the A stream, the blue
color corresponds to the B stream.
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Frame g X
name value s value | %
streamidis... 473\... 473\...
type B B
siZe
total 5044 83T —
intra pred 52 30
inter pred 11850 2109 = —
transform 12448 2817 &
gp
avg 27.107 34.044 ——
Stream A Stream B Frame

Figure 9.

3.2.6 New Task

Elecard Video Quality Estimator GUI — Frame Panel

To open new media files for analysis and comparison, click the E5 button or click the File tab and
select the corresponding menu item. A dialog window will open.

Add the required streams to the File A, and/or File B and file RAW fields from the Open file dialog
window by clicking the browse button or clicking the recently opened files button. Select the required
parameter for the RAW file in a drop-down box.

Select metrics by enabling the corresponding checkboxes.

Enable checkboxes for ROI (region of interest), auto synchronization and start quality estimation after
closing the dialog, if required. Specify ROI values and choose normal or inverse type of the analyzed
area. Specify the frames range for auto synchronization mode.

www.elecard.com
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Mew task... X

file A:
|D: /Media/bbb_x255_300kbps. 255 =] ([ SRAIE
info : 1280x720 25

file B:
[D:/Mediabbb_x265_1530kbps. 265 B ~| x
info : 1280%720 25

file RAW:
|D:ﬂﬂ1edia;’bbb.wv v - B3| C || X

metrics:

[ APSMR (Average Peak signal-to-noise ratio)

[] Delta (Difference of the color components in the correspondent points of image)
[[] MSAD {Absolute difference of the color components in the correspondent points of image)
] MSE (Mean Squared Error)

MNCI (A Universal Image Quality Index)

PSMR (Peak signal-to-noise ratio)

S5IM (Structural SIMilarity)

] VIF (Visual information fidelity)

] WMAF (Video quality assessment based on multi-method fusion)

] VMAF (Phone) (Video quality assessment based on multi-methed fusion)

VOM (Video quality metric)

[] use region of interest (x; y; w; h): -1:-1:-1;-1 normal

[] Use auto synchronization window (frames count): AB

Start quality estimation after dosing this dialog

oK Cancel

Figure 10.  Elecard Video Quality Estimator GUI — New task window

Note: All input files should have the same resolution. If files differ in length, then the shortest length is
taken for calculation: metrics are not calculated for the frames beyond the shortest file length.

3.2.7 Options Dialog

To configure file settings, binding and saving modes, open the Options dialog by clicking the %
button or selecting the corresponding File menu command, and choose the required tab.
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Options >
Main Visualization Binding Save License

Mumber of recent files in list:
[] Delete missing recent files from list automatically

Show Task dialog when reopen
Always show Property dialog when opening a raw stream
[] use the native chroma format in metric calculation

Open With List{name; [path]; [shortout]):
StreamEye; "D:'\Elecard StreamEye Versions\StreamEye_4.4.064573, 15

[] set Position from I Frame

CAUTION: Be aware of the fact that it overwhelmingly causes
improper operation of positioning.
You can use it only at your own risk and respansibility.

Restore Defaults Cancel

Figure 11.  Elecard Video Quality Estimator GUI — Options — Main Tab

The following table describes the Main tab in the Options dialog.
Table 2. Elecard Video Quality Estimator — Options dialog — Main tab

Control Function
Number of recent files in list Shows a number of recent files being saved in a list.
Delete missing recent files from Allows deleting missing files from the recent list automatically when opening a
list automatically file from the list.
Show Task dialog when reopen Allows reopening the task dialog with previously saved configurations.

Always show Property dialog

. Enables showing Property dialog when a raw stream is opened.
when opening a raw stream

Use the native chroma format in

metric calculation Allows specifying parser initialization buffer.

Allows opening the file currently opened in Video Quality Estimator with

Ol Wit (L] another application (see details below).

Allows starting calculation from the first | frame in a stream.

Set position from I frame Note: Be aware of the fact that it overwhelmingly causes improper operation of
positioning. You can use it only at your own risk and responsibility.

The Options Dialog allows opening a file with an external application. To open the file currently
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opened in Video Quality Estimator with another application, specify its name and path in the Open
With List field according to parameters specified there. The parameters path and shortcut are optional.
If the path parameter is not specified, default application or player supporting a file format and
installed in the system is opened. Each string specified in the Open With List field corresponds to an
individual item in the menu File — Open with, that allows easy switching between applications or
players after configuring the field.

Note: The Restore Defaults button allows you to reset set options to their original values. Functionality of this
button is not applicable to the License tab.

Options >
Main Visualization Binding Save License
Color Theme: Default 7

IUse different colors to display output

Restore Defaults Cancel

Figure 12.  Elecard Video Quality Estimator GUI — Options — Visualization Tab

The Visualizaion tab allows configuring the display of the application interface.

By switching to the Dark Color Theme, the VideoQuest interface is displayed in the dark mode (by
Default the light background is set).

The Use different colors to display output option enables colorization of output values with different
colors in the Frame and Stream panels.
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Options >

Main Visualization Binding Save License

Allows exchanging information between applications contained in Elecard
StreamEye Studio.

Localhost Port: 34325

Receive messages from the application:
StreamEye
StreamAnalyzer
VideoQuest
YUV Viewer

Messages type to be received from the selected application:
Position

positioning in bitstream in different applications but within the same
video file (available only if the same video file is opened in different
applications).
Comments

allows receiving comments from the selected applications (available
for all selected applications contained in Elecard StreamEye Studio).

GUI Synchronization
allows synchronizing the application window size and switching
between internal controls (available for VideoQuest 4 only)

Restore Defaults Cancel

Figure 13.  Elecard Video Quality Estimator GUI — Options — Binding Tab

The Binding tab contains settings that allow configuration of the interaction between Elecard
StreamEye Studio applications. In the Binding Mode, exchanging information between applications is
provided via a specified port. By activating checkboxes, you can select which applications should send
messages and set messages type that should be communicated. Additionally, the synchronization of
applications window size and switching between controls can be enabled.
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Options >

Main Visualization Binding Save License

File data type CsV
Decimal separator in .csv file Lo
Data delimiter in .csv file o

Add distribution info to:
Stream Info

Index Info
Add metric info to Index file for:
Y Component
[] U Component
|:| V Component
Average Value

CQutput YUV data type YUY~

Restore Defaults Cancel

Figure 14.  Elecard Video Quality Estimator GUI — Options — Save Tab

The following table describes the Save tab in the Options dialog.
Table 3. Elecard Video Quality Estimator — Options dialog — Save tab

Control Function

Allows selecting the format in which metrics data should be saved (the CSV
or JSON format).

Allows selecting decimal comma or decimal dot to separate an integer part
from a fractional one of a real number.

File data type

Decimal separator in .csv file

Data delimiter in .csv file Allows selecting comma or semicolon to specify boundaries in data stream.
Add distribution info to Allows adding distribution info when saving a file: Stream Info, Index Info.
Add metric info to Index file Allows adding metric info for the selected parameters when saving: Y

for Component, U Component, V Component, Average Value.

Allows saving YUV data in one of the following formats 1444, 1422, IYUV,
Output YUV data type NV12, NV21, P444, RGB24, RGB32, UYVY (Y422, UYNV, HDYC), V210,

V400, V444, ,Y42B, YUY2 (YUNV, V422, YUYV), YV12, YV16, YVYU.
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3.3 Hot Keys

For tabs, functions and modes switching press hot keys described hereto.
e Ctrl+O — opens a media file.
e Ctrl+R — opens the recently opened file.

The following hot key combinations are used for Navigation:
e Ctrl + Shift + Left  — starts the Go to beginning function.

o Alt+ Left — goes to the Previous frame.
e Ctrl + Space — starts and stops the Play function.
e Alt+ Right — goes to the Next frame.

e Ctrl + Shift + Right — starts the Go to end function.
To change View configuration of panel controls, use the following hot keys:

e 2 — shows / hides all controls.
e F3 — shows all (controls).

For configuring information panels, use the following hot key combinations:

o ALT+1 — shows / activates the stream A panel.
o ALT+2 — shows / activates the stream B panel.
o ALT+3 — shows / activates the frame panel.

The following hot keys are used for switching Output Panels:

e CTRL+1 — activates the A panel.

e CTRL+2 — activates the B panel.

e CTRL+3 — activates the RAW panel.

e CTRL+4 — activates the Difference panel.
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4. Command line tool

Elecard Video Quality Estimator Command Line tool is designed for insight into MPEG-1/2,
H.264/AVC, H.265/HEVC, H.266/VVC, VP9, AV1 and AVS3 video compression standards and ever
fast quality and compliance check.

Video Quality Estimator Command Line tool allows automatic analysis of video arrays. You can
customize a sequence of commands to perform your specific tasks and automate your routine tasks.
Get to the command prompt by clicking Start->Run and type ‘cmd'. Then enter the command to start
the application first and proceed with the command line options. In general, the syntax is as follows:
VQConsole.exe config.xml /inA:input.avc /out:output/input avc /ref:ref input.yuv

Note: You should not relocate the <product> console without all the other applications of the product
contained in the installation pack, otherwise the console application will not start.

4.1 Configuration File

Configuration file — contains all the commands performed by the application and reflects overall
operation results:

<?xml version="1.0"?>
<VQ version="1">

<inputA file=".." stream="-1(default)" offset="0 (default)"/>

<inputB file=".." stream="-1(default)" offset="0(default)"/>
<reference file="" type="IYUV (default)/[*Upsampler Type]"

offset="0 (default)" step="1(default)"/>

<output separator=". (default)/," delimiter="; (default)/," file=".."/>

<roi x="0" y= "O0" width="0" height="0" inverse="true\false"/>
<sync window="0 (default)" source="AB/ARaw/BRaw"/>
<range span="all (default)/start - stop"/>
<info>
<stream distribution="on (default)/off" file="."/>
<index distribution="on (default) /off" file=".."/>
<metrics data="All (default) |AB|ARaw|BRaw"
nativeChroma="Yes (default) /No" component="All (default) |Y|U|V|A"

type="PSNR (default) |APSNR|SSIM|.. " file=".."/>
<data source="A|B" format="IYUV (default)/YV12" file="."/>
<difference type="compare/subtraction/temperature/psnr/psnr clip"
source="AB/ARaw/BRaw" format="IYUV (default)/YV12" file="."/>
<message source="A|B" level="all (default)/message/warning/error"
file=".."/>

</info>

</VO>

4.2 List of Commands

List of commands contains information on the commands and all parameters, which may be used
within a command, and their description.

Command Description

<inputl/> The tag is used to configure the input file;
<input2/>
Specifies the elementary video stream number, if number of streams exceeds one.
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«-1» — first available elementary video stream. It is set by default.
stream Starting frame for further calculation. Offset from the beginning up to the specified frame in the
stream. It is expressed in frames.

offset
<reference/> The tag is used to configure the reference file;
type Defines the format of the raw data. (YV12 (is set by default) / I'YUV are used now. More
formats to be supported in the next updates.);
file Sets the path to the reference file.
offset Offset from the beginning up to the specified frame in a reference stream. It is expressed in
frames. “0” is set by default.
step Coefficient used for calculation of a successive frame number for further analysis. “1” is set by
default.
<output/> The tag is used to configure the output file;
separator Allows selecting decimal comma or decimal dot to separate an integer part from a fractional one
of a real number.
delimiter Allows selecting comma or semicolon to specify boundaries in data stream.
file Sets the output file path.
<roi/> Region of interest selected for measurement;
normal Measures the specified field of the frame;
inverse Measures the whole frame field except the specified part
<sync/> Specifies the frames range for auto synchronization mode. “0” is set by default.
<range/> The tag is used to define the range of analyzed frames;
span Defines the range of frames (all (by default) /start - stop), 'start' - number of the first analyzed
frame, 'stop’ - number of the last analyzed frame.
<stream/> The tag is used to output general information about the analyzed stream;
distribution Contains information on data distribution by type of coding units (on (by default) / off);
file Sets the path for the output stream information.
<index/> The tag is used to output information about frames (offset, frame type, frame size, average
quantizer, etc.);
distribution Contains information on data distribution by type of coding units (on (by default) / off);
file Sets the output file path where information on frames will be saved.
<metrics/> The tag is used to output information on quality metrics;
data Specifies the type of the streams selected for metrics calculation and saving: All (by default) |
AB | ARaw | BRaw;
type Specifies the metric type: PSNR (by default) | APSNR | SSIM | DELTA | MSAD | MSE | VQM |
NQI | VIF | VMAF | VMAF phone.
file Sets the output file path where information on metrics will be saved.
<data/> The tag is used to save output decoder information on any decoding step;
source Defines the type of the source for metrics calculation: A | B | Raw
format Defines the format for saving data (I'YUV (by default));
file Sets the output file path where the data will be saved.
<difference/> The tag is used to output information on difference metrics
type Defines the type of difference (compare/subtraction/temperature/psnr/psnr clip). This is the
required parameter for this tag. Its default value should be set. If the value is not set, this tag will
be skipped;
source Specifies the source type for difference calculation: AB | ARaw | BRaw;
file Sets the output file path where information on difference will be saved.

4.3 Features of Command Line Tool

e Analysis the whole array of video files automatically;
e Addressing specific and complex challenges with a few lines of commands;
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e Retrieving submitted results as a text file in CSV format for easy viewing in Excel;
e Customizing a sequence of commands to perform your specific tasks;
e Accelerating and automating your regular tasks.
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